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Using Help
Use the Dashboard Help button to find the help you need.
Index Help
1. Double-click the Help button to see an index of help topics.

2. Click Introducing Dashboard to see a brief explanation of Dashboard.

3. Click a topic from the How To list to see instructions for that task.

Context Help
1. Click the Help button and the cursor becomes a question mark.

2. Put the question mark on any item on Dashboard and click there to see specific help for that item.



Introducing Dashboard
Dashboard for Windows is the convenient push-button utility which gives you quick access to
and maximum control over your Windows programs.
Dashboard includes these features (and many more):

Convenient menus and buttons for launching programs.

Drag-and-drop support for printing, plotting, and faxing.

Miniature screens that make it easy to work with several full-screen programs at once.

An alarm clock with a built-in snooze alarm.

"At a glance" feedback to let you know which programs are running and how much memory you are 
using.



Dashboard Panels
About Button
Alarm Clock 
Customize Button 
Extended Screens 
Help Button
Layout Menu
Maximize Button
Minimize Button
Printer Manager
Program Menu
Quick Launch Buttons
Resource Gauge
Show Program Menu Button
Sizing Bar
System Menu
Task Menu
Title Bar



Checking Your Resources
To help you check your total free memory and Windows System Resources, Dashboard 
includes these tools:
The Resource Gauge shows the level of Windows System Resources currently available. As it 
gets closer to E (empty), you may not be able to open new programs.
The Warning Indicator blinks and sounds an alarm as you reach the alarm level for either 
available free system memory or system resources. Double-click to see a list of all programs 
currently running. Try closing programs if you are running out of memory.
The Memory Meter shows the total amount of free system memory. The numbers are in 
kilobytes.
You can see more detailed information about your resources and system by double-clicking 
the Resource Gauge on Dashboard.
See Also
The Resources Dialog Box
Resources Preferences



Changing the Program Menu
The Program Menu displays a list of program groups you can work with from Dashboard. These groups 
are the same as those you see in the Program Manager.    If Dashboard is configured as the shell, then 
you can make changes to these groups and to the Program Menu itself using the Customize dialog box.    
You can modify, add, and delete groups using Dashboard and change the order of the Program Menu 
buttons.    If Program Manager is running as the shell, these functions are disabled.

When you modify program groups or add a new group in Program Manager, these changes will not be 
reflected in the Dashboard groups until you click the Reread from Program Manager button in the 
Program Menu preferences.    If you close Dashboard and then run it again, the changes will also take 
effect.

If Dashboard is the shell, you can manage groups directly from the Dashboard Customize dialog box.

1. To open the Customize dialog box with the Program Menu preferences displayed, 
double-click the right mouse button on one of the Program Menu buttons.

2. To make a change to a program group, click that program group in the list, and then click one of the 
following buttons to choose which task you want to perform on the selected program group.

Modify:    Changes the color of the key on the program group button, or enters a new description for 
the program group.
Open:    Opens the program group.
Delete    Deletes the program group from Dashboard and the Program Manager.
New:    Creates a new program group.

To change the position of a program group on Dashboard, click on the group in the list and drag it to its 
new position in the list.    The position of the program group's button on Dashboard is changed 
appropriately.

Regardless of whether Dashboard is the shell of not, you can perform the following:

1. Choose the Show 2nd row of text option if you want the Program Menu buttons to be full size. If this 
option is not checked, the buttons will show only a single row of text.

2. Choose the Show Color Keys option if you want color keys for each program group to be displayed in 
the Program Menu.

3. To update Dashboard with changes made using the Program Manager, click the Reread from 
Program Manager button.

See Also
Managing Program Groups with the Program Menu
Using Custom Dashboard Configurations



Creating Quick Launch Buttons
Use Quick Launch buttons on Dashboard to launch any program directly from Dashboard with a single 
click.    

Creating a Quick Launch button by dragging a program
Drag the program from the File Manager or program window to a Quick Launch panel on the Dashboard.

Creating a Quick Launch button with the Customize dialog box
1. Double-click the right mouse button on one of the Quick Launch buttons to open the Customize dialog

box with Quick Launch preferences.

2. Click New.

3. Enter a title for the button.

4. Enter the correct command line (path name and file name) and working directory for the program. 
Click Browse if you don't know the path name for the program.

5. Choose the Run Minimized option if you want the program to be minimized when you open it.

6. If the program includes an icon file, its icon appears on the Quick Launch button.    If the program 
does not have an icon, Dashboard will display a default icon.    Click Change Icon to change the 
displayed icon.

7. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
Quick Launch Preferences
Using Custom Dashboard Configurations



Customizing the Alarm Clock
You can customize the alarm clock to change its appearance and to set the interval for the snooze button.

1. Double-click the right mouse button on the clock.

2. Click a Clock Type option. Analog clocks show time with minute and second hands pointing to 
numbers, and digital clocks represent time as a number.

3. Click to open the Clock Face drop-down list, and choose an option to specify the appearance of the 
clock you want.

4. Next to Snooze Interval, type the number of minutes in which you want the alarm to reappear after 
you click the Snooze button in an alarm message.

5. Click Alarms to set an alarm.

If you did not install the Sound Driver for PC-Speaker during the Dashboard installation procedure, 
you cannot hear sound with the alarm.    For instructions on installing the driver, see your Dashboard 
Owner's Handbook.

6. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

Resetting the date and time
The Alarm Clock displays the date and time as set on your computer. To reset the date and time, use the 
Windows Control Panel.

See Also
Clock Preferences
Setting an Alarm
Using Custom Dashboard Configurations



Customizing the Printer Manager
You can customize Dashboard Printer Manager to choose which print devices (printers, plotters, and fax 
machines) you want to appear in Dashboard, the order in which they appear, and which printer should be 
the default printer and to specify the icons and descriptions for each printer.

1. Double-click the right mouse button on one of the printer icons.

2. Select a printer device you want to work with from the list on the right.

3. Use the Hide Printer and Show Printer buttons to choose whether the selected device should appear 
in Dashboard.

4. The order in which printer devices are listed indicates the order in which they will appear, left-to-right, 
in Dashboard. To move a printer to its new position on Dashboard, click it in the list and drag it to its 
new position in the list.

5. Use the Description text area to enter a title for the selected printer.    This title will appear on the 
printer icon in Dashboard.

6. Click the Change Icon button to change the displayed icon for the device.

7. Click the Set As Default button to select a default device.

8. Click the Setup button to display the Printer Configuration dialog box for the selected printer. Refer to 
Windows or your printer documentation for more information.

9. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

Installing a new printer, plotter, or fax machine
Dashboard's Printer Manager includes devices that have been installed in Windows. To install new 
devices, use the Windows Control Panel.

See Also
Printer Manager Preferences
Using Custom Dashboard Configurations



Customizing the Resource Gauge
Dashboard includes an alarm that warns you when the total free memory or your Windows System 
Resources are getting low. You can determine the levels at which you want Dashboard to sound an alarm 
when either total free memory or Windows System Resources reaches a certain point.

1. Double-click the right mouse button on the Resource Gauge.

2. Enter exact kilobytes to set an alarm level for free System Memory.
3. Enter a percentage to set an alarm level for available System Resources (memory set 

aside for Windows).
4. Click Alarm Sound to choose a sound for the alarm.

If you did not install the Sound Driver for PC-Speaker during the Dashboard installation procedure, 
you cannot hear sound with the alarm.    For instructions on installing the driver, see your Dashboard 
Owner's Handbook.

5. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
The Resources Dialog Box
Resource Preferences
Using Custom Dashboard Preferences



Customizing Extended Screens
The extended screens feature allows you to create and switch back and forth between as many as nine 
full-sized screens containing different program windows. You can choose the maximum number of 
extended screens you want up to nine, depending on the available space on Dashboard and the your 
resolution of your monitor.

1. Double-click the right mouse button on one of the extended screens to open the Customize dialog 
box with the Extended Screens preferences.

2. Click an option to choose the number of extended screens. 

If a number is grayed out, there is not enough room on Dashboard for that many extended screens. 
To make more room on Dashboard, remove items from Dashboard by clicking on one of the 
Dashboard items listed in the Customize dialog box and selecting Hide Item.    You can then select a 
larger number of extended screens to display.

If you decrease the number of extended screens on Dashboard, any applications contained in the 
removed extended screens (the left or right screens) are moved into the closest extended screen 
remaining on Dashboard.

3. Click one of the background options to select a different background for your extended screens.

4. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
Extended Screens Preferences
Using Custom Dashboard Preferences



Rearranging Items on Dashboard
1. Click the Customize button.

2. Click the item you want to move in the list and drag it to its new position in the list.    As you drag the 
item, the cursor changes to a two-headed" arrow pointing up and down.

The top-to-bottom sequence in the list corresponds to how items are arranged from left to right on 
Dashboard. For example, if you want the clock to be on the far right, drag it to the bottom of the list.

3. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
Dashboard Panels
Using Custom Dashboard Configurations



Using Custom Dashboard Configurations
1. Make all the changes you want in the Customize dialog box. 

2. Choose Save or Save As from the File Menu.

Save saves the current configuration into the configuration file currently being used.    The caption of 
the Customize dialog box shows the name of the current file.    Use Save As to save to a different file 
name.

3. In the Save As dialog box, enter the path and file name for the file in the edit box.    A .cfg extension is 
automatically added to the new file name and the current configuration file now changes to the new 
file name.

4. Click OK, then click Done in the Customize dialog box.

If you don't want to keep the changes, click Undo.

See Also
The Customize Dialog Box



Setting an Alarm
You can set alarms to display a message, set off an alarm sound , or launch a program automatically.

1. Double-click the Alarm Clock on Dashboard.

2. In the Clock Alarms dialog box, click the Add button.

3. Specify a time for the alarm.

Enter the hour and minutes or click the up and down arrows to change the setting.    Select AM or PM 
from the drop-down list.

4. Choose the One Time Only option if the alarm should occur only once. Otherwise, it will occur each 
day at the same time.

5. Next to Alarm Text, type the text you want displayed in the alarm message.

6. If the alarm is to launch a program automatically, enter the path of the program and the working 
directory under Optional Alarm Actions. Use the Browse button to help locate the program and its 
command line, and choose the Run Minimized option if you want the program to be minimized when 
you open it.

7. Choose the alarm's sound from the Sound drop-down list. To hear a sound, select it and click Play 
Sound.    

If you did not install the Sound Driver for PC-Speaker during the Dashboard installation procedure, 
you cannot hear sound with the alarm.    For instructions on installing the driver, see your Dashboard 
Owner's Handbook.

8. Click OK.

See Also
Customizing the Alarm Clock
Using Custom Dashboard Configurations
Clock Preferences



Setting Dashboard Preferences
1. Click the Customize button.

2. Under Dashboard Preferences, choose the Dashboard always in front option if you want the 
Dashboard window in front of all other windows at all times.

3. If you don't choose to have Dashboard always on top, you can set an F-key to bring it to the top when
you need it.

4. Choose the Show Icons in Menus option if you want to display mini program icons on the extended 
screens, Program Menu list, and the Task Menu.

5. Make a choice from the drop-down list under Title Bar Display to customize the appearance of the 
Dashboard Title Bar.    

You can choose the standard Dashboard display or the clock display, which shows the current date 
and time.

6. Make a choice from the drop-down list under Minimized Display to change the icon displayed when 
Dashboard is minimized.

You can choose the standard Dashboard icon, the clock icon, or the extended screens icon.    If you 
choose the extended screens icon, you can switch screens by clicking on the little boxes in the 
minimized icon.

7. To save the changes and close the dialog box, click Done.    

If you don't want to keep the changes, click Undo.

See Also
Using Custom Dashboard Configurations



Launching Programs with Quick Launch Buttons
You can create a set of Quick Launch buttons for the programs you use most often. 
Once a program has been assigned to a Quick Launch button, just click that button to run 
the program.
If there are more Quick Launch buttons than can be shown at one time, use the scroll arrows
to display buttons not currently in view.
See Also
Creating Quick Launch Buttons
Launching Programs with the Program Menu
Launching Programs with the Layout Menu
Launching Programs with the Run Command
Launching Programs with the Clock Alarm



Launching Programs with the Program Menu
1. Select a program group from the Program Menu listed across the top of Dashboard. Click once to see

the program items listed on a menu, or double-click to see the items displayed as icons in the 
program window.

If all the Program Menu buttons are not displayed on Dashboard, click the scroll arrows to display 
them.

2. Select the program you want to run by clicking the item in the menu or double-clicking the icon in the 
program window.

If the list of programs is too long to fit on the menu, click the More command on the menu.    The 
program group window opens, and you can scroll through the window to see all the items.

See Also
Launching Programs with the Quick Launch Buttons
Launching Programs with the Layout Menu
Launching Programs with the Run Command
Launching Programs with the Clock Alarm
Managing Program Groups



Launching Programs with the Layout Menu
1. Click the Layout Menu button (the third button on the left side of the Title Bar) or choose Layout Menu

from the System Menu.

2. Click the Load Layout command.

A cascading menu of previously saved layouts appears.

3. Click the layout that you want to load in the cascading menu.

All the programs associated with the selected layout are launched.    The programs are displayed on 
the extended screens according to the layout you saved.

See Also
Launching Programs with the Quick Launch Buttons
Launching Programs with the Program Menu
Launching Programs with the Run Command
Launching Programs with the Clock Alarm



Launching Programs with the Run Command
1. Click the Task Menu button (the second button on the left side of the Title Bar) or choose Task Menu 

from the System Menu.

2. Choose Run.

3. Enter the command line for the program to run. Use the Browse button to find the program's location 
and enter the information in the command line. Choose the Run Minimized option if you want the 
program to be minimized when you open it.

The Command History list shows the last twenty commands that have been entered. If the command 
you want to enter is already listed, you don't have to type it or browse to find it. Simply double-click it 
to enter the information in the command line.

4. Click OK.

See Also
Launching Programs with Quick Launch Buttons
Launching Programs with the Program Menu
Launching Programs with the Layout Menu
Launching Programs with the Clock Alarm



Managing Extended Screens
Dashboard's extended screens make it possible to work with your computer as if it had 
several screens attached to it. Each extended screen on Dashboard represents a full-screen 
view.
The extended screens and their corresponding full-screen views are interactive. For 
example, if you change a full-screen view by closing a window or running a new program, 
the extended screen in Dashboard is updated automatically. Move items on the extended 
screens, and their corresponding full-screen views change too.    If you change the size of the
original program window, the size of the mini window on the extended screen will change 
accordingly.
To switch back and forth among different programs, click the selector button under the 
extended screen showing the window you want to view.
To move open windows among the extended screens, drag the mini-windows in the 
Dashboard extended screens, or move the full-sized windows by dragging on the title bar.
See Also
Customizing Extended Screens 
Extended Screens Preferences 



Managing Program Groups with the Program Menu
The row of Program Menu buttons under Dashboard's title bar lists the program groups in 
Windows' Program Manager.    Click any program group to see a list of programs contained in
it. When Dashboard is the shell, you can create a program group within anouther group. If a 
program group contains another group, the items in that group are listed in a cascading 
menu.    You can also double-click a program group to see its group window. 
If there are more program groups in the Program Manager than fit on Dashboard, use the 
scroll arrows on the right side of the Program Menu to scroll through the groups.
If Dashboard is the shell and Program Manager is not running, you can perform the following
functions:
Adding a new program menu button
1. Double-click with the right mouse button one of the Program Menu buttons to go into Program Menu 

Preferences.

2. Click the New button.

3. At the New Program Group dialog box, enter the name of the new group and select a color key 
setting.    You can also enter the name of the group file if you want. Do not use an existing group file to
create a new group.

4. Click OK.

Changing the position of a group on Dashboard
1. Double-click with the right mouse button on one of the Program Menu buttons to go to into Program 

Menu Preferences.

2. Click the program group you want to move in the list and drag it to its new position in the list. 

The top-to-bottom sequence in the list corresponds to how program buttons are arranged from left to 
right on Dashboard. For example, if you want the Main button to be on the far left, drag it to the 
beginning of the list.

Deleting a group from Dashboard
1. Double-click with the right mouse button on one of the Program Menu buttons to go into Program 

Menu Preferences.

2. Click the program group you want to delete from the list of program groups. 

3. Click Delete.

Dashboard no longer displays the program group.

Modifying a program group's color key or description
1. Double-click with the right mouse button on one of the Program Menu buttons to go into Program 

Menu Preferences.

2. Click a group in the Program Groups list.

3. Click Modify.

4. Enter a new group description or select a new color key setting.

The group description you enter will appear on the Dashboard program menu button.

Regardless of whether Dashboard is the shell or not, you can do the following:

Specifying a height for the Program Menu
1. Double-click with the right mouse button on one of the Program Menu buttons to go into Program 



Menu Preferences.

2. Use the Show 2nd row of text option to display two rows of text on the Program Menu buttons..

Choosing whether to display colors in the Program Menu
1. Double-click with the right mouse button on one of the Program Menu buttons to go into Program 

Menu Preferences.

2. Use the Show Color Keys option to add color tabs on the Program Menu buttons.

Updating Dashboard with changes made in Program Manager
1. Double-click with the right mouse button on one of the Program Menu buttons to go into Program 

Menu Preferences.

2. Click the Reread from Program Manager button.

See Also
Launching Programs with the Program Menu 
Managing Program Groups with Program Windows 
Program Group Preferences 



Moving and Resizing Dashboard
Moving
1. Put the cursor on the Title Bar.

2. Click and drag to move.

Resizing
1. Put the cursor on the sizing border on the left or right edge of Dashboard. The cursor becomes a 

double-headed sizing arrow.

2. Click and drag to resize. The size of Dashboard is limited by the number of items on Dashboard that 
can be expended or hidden from view.    For example, if the Dashboard window only has one printer 
icon and one Quick Launch button, there's probably no reason to resize.    But if your computer has 
multiple printers, you may have to resize it accordingly. You cannot make Dashboard bigger than is 
necessary to display all items adequately.

Enlarging Dashboard may cause some of its panels (such as the panels for the printers or the Quick 
Launch buttons) to be too big to show all of their items.    When that happens, panels on the left will 
have priority over panels on the right.    For example, if the Quick Launch panel is to the left of the 
printers' panel, more Quick Launch buttons will be visible than printers.    Scroll arrows will be next to 
the printers so you can scroll to see the other printers.    To take advantage of this feature, rearrange 
the panels that you work with most often to be on the left side.



Printing and Faxing
The Printer Manager controls all of the printers, fax machines, and plotters you have 
installed and configured in Windows.
Printing from Dashboard
1. Open the File Manager and select a file to print or open a Dashboard program group window.

2. Click and drag the file to the appropriate printer icon on Dashboard.    If the printer is not currently 
displayed on Dashboard, use the scroll arrows on Dashboard to display it.

If the application with which the file was created is not registered properly with Windows, you cannot 
print the file by dragging it to Dashboard.    You can check the Windows Registration Info Editor to see
whether your application is registered.    For instructions on opening the Windows Registration Info 
Editor and for registering an application, see the Readme.txt file that came with your Dashboard 
program.

Choosing a default printer
The green light    denotes the default printer. To choose a different default printer, click the 
default printer button.
Scrolling in Dashboard to see other printers
If Dashboard is not wide enough to display all printers, the Print Manager portion of 
Dashboard will include scroll arrows. Click the scroll arrows to see printers that aren't 
currently visible.
Displaying a printer's full name and description
Click a printer icon to see the full name and description.
Working with the printer's configuration
Double-click to see the Printer Configuration box, and change the appropriate settings..
Installing new printers
The Printer Manager offers a quick and easy way to handle all your installed printers. 
However, the Printer Manager does not install printers. To install a new printer, use the 
Windows Control Panel. Refer to your Windows documentation for more information.
See Also
Printer Manager Preferences 



Using Dashboard with a Keyboard
You can use certain keys to work with Dashboard.    The information in this topic explains 
what you can do with each key.
F12
Bring the Dashboard window to the front of other windows.    (You can change to some other 
F-key using the Customize button.)
Alt-(character)
Choose a button or menu command that has its selection character underlined.    For 
example, if a button is labeled Add, the letter A is the letter for selecting the Add key, and 
pressing Alt-A is equivalent to clicking the button.
Alt-Spacebar
Show the System Menu.
Alt-Tab
Cycle through the open programs running under Windows. Use this option to bring the 
Dashboard window into focus.
Ctrl-Alt-Cursor Keys
Move (reorder) items on a list in the Customize dialog box.
Cursor Keys (up/down/left/right)
Select items from menus and from groups within a dialog box.    If you use Tab to select an 
item on the Dashboard window, using the cursor keys will cycle through individual 
components of the items.
End
Move to last item on a list.
Enter
Equivalent to double-clicking the mouse on the selected item. In a dialog box, equivalent to 
clicking on the OK button.
Esc
Exit a menu. Cancel out of a dialog box.
Home
Move to first item in a list.
Shift-Tab
Tab key functions in reverse.
Spacebar
Selects chosen items on the Dashboard window. Equivalent to clicking the mouse.
Tab
When the Dashboard window has the focus, use the Tab key to cycle through and change the
keyboard focus on different sections of it.    When a dialog box is active, the Tab key cycles 
through groups in it. (use cursor keys to choose items within a group.)



Creating Layouts
You can use Dashboard layouts to open all the programs you want to work with, already 
positioned in the extended screens and ready to go.    For instance, if you want to work with 
WinWord on extended screen 1, Paintbrush on extended screen 2, and the File Manager 
minimized on extended screen 3, you can save that arrangement as a layout.    Then, when 
you open that layout, all of those programs will automatically open in the same screen 
location.
If you have another project that requires working with some other programs in a different 
arrangement, you can save them as another layout and reload them with a single command 
when you need to work on this project.
1. Open all the programs you want to include in the layout.

2. Arrange the programs on the extended screens.

3. Choose Save Layout from the Layout Menu.

4. Enter a name for the layout.

5. Click OK.



Editing Layouts
1. At the Save Layout dialog box, select a program from the programs list then click Edit.

The Edit Layout dialog box appears.    The dialog box contains the command line and working 
directory for the selected program.

2. To change the command line or working directory, enter the new information in the appropriate field. 

3. Enter a name for the program in the Application Name box.    This name is a descriptive name, not a 
filename.

4. Enter the correct command line and working directory in the Command Line box.

If you want a particular file instead of just the program to open as part of a layout, enter the command 
line for loading the file here.

5. Choose a size for the program window from the Window Size pull-down menu.

6. To exit the Edit Layout dialog box and save any changes, click OK.

7. To exit the Edit Layout dialog box without saving changes, click Cancel.



Loading Layouts
1. Click the Layout button (the third button on the left side of the Title Bar) or choose Layout Menu from 

the System Menu.

2. Choose Load Layout from the Layout Menu.

A cascading menu of previously saved layouts appears.

3. Click the layout that you want to load in the cascading menu.

All the programs associated with the selected layout are launched.



Managing Layouts
To change the program information in a layout, choose Manage Layouts from the Layout 
Menu.    The Manage Layouts dialog box opens.    Use the Manage Layouts dialog box to make
any of the following changes to your layout.
Removing a layout
1. Select the layout in the Layout list.

2.  Click Delete Layout.

Changing the name of a layout
1. Select the layout in the Layout list.

2. Click Rename.

3. Enter the new name in the Rename dialog box and click OK.

Removing a Program from a Layout
1. Select the program in the Applications for Layout list.

2. Click Delete.

Editing a program's specifics
1. Select the program in the Applications for Layout list.

2. Click Edit.

3. Enter the appropriate information in the Edit Layout dialog box.

Exiting the Manage Layouts dialog box
1. To exit the Manage Layouts dialog box and save any changes made, click Save Changes.

2. To exit the Manage Layouts dialog box without saving changes, click Cancel.



Launching Programs with the Clock Alarm
1. Double-click the Alarm Clock on Dashboard or click the Alarms button in the Clock Preferences dialog

box.

The Clock Alarms dialog box opens.

2. Click Add to add a new alarm or Edit to change an existing alarm.

The Alarms Setting dialog box appears.

3. Set the time you want Dashboard to launch the program.

4. If you want the alarm to play a sound, click Alarm Sound to choose a sound.
5. If you want the program to launch automatically only once, check the One Time Only box.

6. Enter the name, path, and working directory for the program in the Run Program box.

7. If you want the program to run minimized, check the Run Minimized box.

8. Click OK.

See Also
The Alarm Settings Dialog Box



Managing Program Groups with Program Windows
When you double-click a program group in the Program Menu, the Dashboard program group
window opens and displays program items as icons. If Dashboard is the shell, you can click 
and drag programs into other group windows, and even create groups within groups. These 
functions are disabled if Program Manager is running.
If Dashboard is the shell, you can perform the following in Program Windows:
Moving and copying a program from one group to another by dragging the icon
1. Open both group windows by double-clicking in the Dashboard Program Menu.

2. Click and drag the program item icon from one window to the next to move the item. To copy a 
program, hold the Control key and click to drag the program item to another window.

Moving a program from one group to another using the Move command
1. Open the group window from which you want to move the program.

2. Select the program item you want to move.

3. Choose Move from the File menu.

4. Enter the name of the group to which you want to move the program.

5. Click OK.

Copying a program from one group to another
1. Open the group window from which you want to copy the program.

2. Choose Copy from the File menu.

3. Enter the name of the group to which you want to copy the program.

4. Click OK.

Creating a new program group within an existing program group
1. Open the existing group window by double-clicking in the Dashboard Program Menu.

2. Choose New Group from the File menu.

3. Type a name for the group and click OK. Enter a group file name as an option. Do not use an existing 
group file name.

The new group is displayed as an icon. 

4. Double-click the icon to open the new group window.

Creating a new program item
1. Open the group window by double-clicking in the Dashboard Program Menu.

2. Choose New Item from the File menu.

4. Enter a title for the program item.

5. Enter the correct command line (path name and file name) and working directory for the program. 
Click Browse if you don't know the path name for the program.

6. Choose the Run Minimized option if you want the program to be minimized when you open it.

7. Click OK.

Changing a program item's properties
1. Open the group window by double-clicking in the Dashboard Program Menu.

2. Click the program item for which you want to change the properties.



3. Choose Properties from the File menu.

4. Enter the new information in the Program Item Properties dialog box.

5. Click OK.

Deleting a program item or program group
1. Open the group window by double-clicking in the Dashboard Program Menu.

2. Click the program item or program group you want to delete.

3. Choose Delete from the File menu.

Deleting a program group will delete all of the items and groups contained within it.

If Dashboard is not the shell, you can use the Properties command to view the properties of 
a program item or program menu. However, the information within it can not be edited.



Running Dashboard as a Shell
If you run Dashboard as a shell program, Dashboard will be the first program to run when you start 
Windows, instead of the Program Manager.    Running Dashboard as a shell lets you control Windows 
with Dashboard only.

1. Click the Customize button.

2. Under Dashboard Preferences, check the Use Dashboard as Windows Shell box.

3. Click Done.

Dashboard displays a message saying you need to restart Windows to implement the change.

4. Click Yes to restart Windows immediately or click No to remain in Windows and continue to work with 
Dashboard.

If you click No, the next time you restart Windows, Dashboard will be displayed as the shell.

When Dashboard is the shell, you can edit, move, create and delete groups, as well as reorder the groups
on Dashboard's Program Menu.



Running Dashboard under Windows 3.0
The information in this topic only applies if you're running Microsoft Windows version 3.0 on 
your computer.    If you're running Windows version 3.1, ignore this topic.
Dashboard for Windows operates slightly differently under Windows 3.0 than under Windows
3.1.    You will still have access to Dashboard's main features, it's just that some work with 
minor differences.
If you aren't sure which version of Windows your computer uses, start Windows and notice 
its version number on the initial Windows screen.    If Windows is already running, choose the
About command from the Help menu of the Program Manager.
Installing Dashboard for Windows 3.0
The steps to install Dashboard under Windows 3.0 are exactly the same as under 3.1.    The 
only difference is that the process will copy the following files into the Windows 3.0 System 
Directory:

TOOLHELP.DLL
COMMDLG.DLL
VER.DLL
SHELL.DLL
DDEML.DLL
SMALLB.FON
SMALLE.FON
SMALLF.FON

The first five files (that end with the .dll extension) help control how Dashboard runs under 
Windows 3.0.
Do not delete, move, rename, or modify these .dll files in the Windows 3.0 System Directory. 
If you do, Dashboard for Windows will not run correctly.
A note about the .DLL files:    These .dll files are common files that may be used by other 
Windows 3.0 applications.    Therefore, if the files already exist in the System Directory and 
are an older version, the Dashboard installation process will update them.    However, if you 
try to install Dashboard while another program is currently using the .dll files, Dashboard 
cannot update these .dll files.    A message will tell you what to do when that occurs.
The other files copied into the Windows 3.0 System Directory when you install the 
Dashboard are font files (they end with the .fon extension.    To install these font files in your 
Windows System Directory, all you have to do is quit Windows and then restart.
A note about the font files:    The font files control the appearance of text on the 
Dashboard.    If you don't quit Windows and re-start before running Dashboard, the text on it 
will be too bit.
Using the Dashboard under Windows 3.0
This section explains the slight differences between using the Dashboard under Windows 3.0
instead of Windows 3.1.
Choosing from menus with a mouse:    To see a menu, click on it and release the mouse 
button.    The menu will then appear.    (In Windows 3.1, the menu appears as soon as you 
click.    You do not have to release the mouse button.)
Dragging and dropping to print, fax, or create a new Quick Launch button:    You cannot drag 
and drop icons or files onto the Dashboard with Windows 3.0.
Bringing the Dashboard to the front of other running programs:    Use Alt-Tab to cycle through
open programs to find the Dashboard, and then release the Alt-Tab keys.    The Dashboard 
will become the active program.    (Under Windows 3.1, you can set an F-key to bring it to the



front, and you can set an option to always have the Dashboard in front.    Neither of these 
options are available for Windows 3.0, and their choices will be grayed out in the Dashboard 
Customize dialog box.)
Matching the appearance of the Program Window on Extended Screen:  Occasionally, the 
appearance of a program window on the Dashboard's extended screen may not match its 
actual position (like it does with Windows 3.1).    When you open a program, it won't appear 
on the extended screen right away.    To make the program appear, click on the extended 
screen window or the selector button.    You can also choose the Update Screens command 
from the Dashboard Task menu.
When an application's window is maximized or minimized, it will not appear on the extended
screen until you click on the extended screen or the selector button, or choose Update 
Screens from the Task menu.
Customizing the Program Menu: If you set Dashboard to be the shell for Windows (the 
process to do this is explained in your Dashboard Owner's Handbook) you can manage 
program groups directly from the Dashboard Customize dialog box.    Click the Customize 
button on the Dashboard and then choose the Program Menu option.    The choices for the 
Program Groups will all be available.
However, if Dashboard is not the shell and the Windows 3.0 Program Manager is running, 
some choices will not be available:    you cannot add, delete, or modify program groups from 
the Program Menu option in the Customize dialog box.    In addition, some commands will not
be available from the File menu in Dashboard Group windows.    The unavailable commands 
are:    New Item, New Group, Move, Copy, and Delete.    The Properties command is available,
but its options are for information only.    You cannot change any of the properties from the 
Dashboard Group window.
You can still make changes to the groups when Dashboard is not the shell by using the 
Program Manager.    To see those changes reflected on the Dashboard, click on the 
Dashboard's Customize button, choose Program Menu and click the button, "Reread from the
Program Manager."
If you upgrade to Windows 3.1
You don't have to re-install the Dashboard program when you upgrade to Windows 3.1.    If 
you install Windows 3.1 into the same directory as version 3.0 (and overwrite version 3.0), 
the program group for Dashboard will be retained when you run Windows Program Manager.
However, if you install Windows 3.1 into a different directory, you'll have to re-create the 
Dashboard program group in Program Manager.
In either case, when you run Dashboard under 3.1, all of the Dashboard's functions will be 
available to you and you can disregard this supplement to your Dashboard Owner's 
Handbook.



Using Dashboard's Readme Files
Your Dashboard program disk contains    two readme files that are copied to your hard disk 
during the Dashboard installation process.    These readme files contain supplemental 
information about Dashboard for Windows that is not included in your Owner's Handbook.
Readme.adv explains how to modify the Dash.ini file.    There are three situations when you 
will want to modify it:

-If you create a layout with the Dashboard, but one or more of the programs on that 
layout do
not open properly

-If you want to add more sounds for the Dashboard's alarms
-If you want to use a monitor with a grayscale setting.

Readme.txt contains information on the following subjects:
-New Dashboard features
-Using the Norton Desktop for Windows with Dashboard for Windows
-Using the After Dark screen saver with Dashboard for Windows
-What to do if a program doesn't install properly
-What to do if you set Dashboard as the Shell and Windows won't run
-What to do if a program loads but its window doesn't appear
-Using Dashboard with Windows 3.0

To see any of this information, open the appropriate readme file.



Using Dashboard with a Grayscale Monitor
If you want to use Dashboard with a grayscale monitor, such as the monitor on a laptop 
computer, you can change the Dash.ini file to improve the grayscale rendition of certain 
Dashboard features.    For example, the default printer light on the Dashboard will be 
displayed as black, as will some of the other Dashboard colors.
In the Monitor paragraph, the possible settings are:

GrayScale=0 not set to grayscale
GrayScale=1 set to grayscale

To set the monitor to grayscale:

1. Double-click on the Dash.ini file to open it as a Notepad file.

2. In the Monitor section of the .ini file, change the setting to:

GrayScale=1

3. Choose Save from the Notepad File menu.

4. Choose Exit from the Notepad File menu.

The Dashboard will now appear in grayscale.    To change the monitor back later, re-set the Monitor 
paragraph to GrayScale=0.



Removing Dashboard
If you want to remove Dashboard from your system, you can do so by using the Remove 
Dashboard icon in your Dashboard program group.
1. Double-click the Remove Dashboard icon.

Dashboard displays a message asking if you want to remove Dashboard for Windows from your 
system.

2. If you don't want to remove Dashboard, click Cancel.

If you want to remove Dashboard, click Remove.

Dashboard displays the Remove Dashboard dialog box containing the path for the Dashboard 
program.

3. If you don't want to remove Dashboard, click Cancel.

If you want to remove Dashboard, click OK.

Dashboard is removed from your system.





About Button
The About button shows information about Dashboard, including the product number, 
product version number, and copyright information.



Alarm Clock
The Alarm Clock shows the date and time set on your computer. Double-click to add or edit 
an alarm and to configure the way the clock looks.
You can customize the clock face to be analog or digital.    You can also display the clock's 
date a and time information on the Dashboard title bar.
See Also
Customizing the Alarm Clock 
Setting an Alarm 



Customize Button
Use the Customize button to personalize different features of Dashboard and set the 
preferences for different items on Dashboard. You can use the Customize dialog box to 
change the positions of items on Dashboard, and you can choose whether to show or hide 
particular items.    You can also set Dashboard to always be displayed in front of the Program 
Manager.    You can save specific configurations of Dashboard in files and load those 
configurations as needed.
See Also
The Customize Dialog Box 



Extended Screens
Use this section of Dashboard to position currently active program windows on Dashboard's 
extended screens. The extended screens area contains miniature windows corresponding to 
the open program windows, displaying the icons and titles of programs in those windows.
The extended screens and their program windows are interactive. For example, if you 
change the size or position of a program window, the extended screen in Dashboard is 
updated automatically. Resize or move items on the extended screens, and their 
corresponding program windows change too.
To switch back and forth among different screens, click the selector button under the 
extended screen.
To move open windows among the extended screens, drag the mini-windows in the 
Dashboard extended windows, or move the full-sized windows by dragging on the title bar.
See Also
Managing Extended Screens 



Help Button
Use the Help button to find the help you need.
Click once on the Help button and the cursor becomes a question mark. Put the question 
mark on any item on Dashboard and click there to see specific help for that item.
Double-click the Help button to see an index of help topics. Click a topic to see the 
instructions you want or click the Search button to locate a particular word or phrase.



Layout Menu
Use the Layout Menu to name, save, and load custom Dashboard layouts or to edit existing 
layouts.    You use Dashboard layouts to open all the programs you want to work with, 
positioned in the extended window according to your specifications.
See Also
Creating Layouts 
Editing Layouts 
Loading Layouts  
Managing Layouts 



Maximize Button
The Maximize button extends Dashboard horizontally to its full width. When you click the 
Maximize button, any panels which are expandable increase in size to use more space in 
Dashboard.    Expandable panels are displayed with scroll arrow buttons to indicate that 
more items exist than are currently shown.
If none of the current Dashboard panels are expandable, Dashboard does not change its 
size. If Dashboard is already maximized, this button returns it to its previous width. 
You cannot resize Dashboard if it is maximized.    You need to click the Restore button to 
return Dashboard to its original size.



Minimize Button
The Minimize button reduces Dashboard to an icon.    You can customize the minimized icon 
using the Customize dialog box.    You can choose between the standard Dashboard icon, a 
clock icon, and an extended screen icon.



Printer Manager
The Printer Manager controls printers, fax machines, and plotters. To print or fax a file, drag-
and-drop the file from the File Manager or a program group window onto the desired printer 
icon. 
Click a printer icon to see the full name and description. Double-click to see the Printer 
Configuration box.    Change the necessary configuration settings, then click OK to save the 
changes.
Choosing a default printer
The green light (or "on" light if you don't have a color monitor) denotes the default printer. 
To choose a different default printer, click on the default printer light.
Scrolling in the Dashboard to see other printers
If Dashboard is not wide enough to display all printers, the Print Manager portion of 
Dashboard will include scroll arrows. Click the scroll arrows to see printers that aren't 
currently visible.
Installing new printers
The Printer Manager offers a quick and easy way to handle all your installed printers. 
However, the Printer Manager does not install printers. To install a new printer, use the 
Windows Control Panel. Refer to your Windows documentation for more information.
The printer icon on Dashboard reflects the orientation of the printer (portrait or landscape).   
If you change the orientation setting in the Printer Configuration box, the icon will change 
also.
See Also
Customizing the Printer Manager 



Program Menu
The Program Menu lists the program groups in the Windows Program Manager. 

Click a program menu button on the Program Menu to see an alphabetical list of programs. Click the 
program item on the list to launch the program.

You can choose the order in which groups appear in the Program Menu, and you can also add new 
groups, modify and delete selected groups, and open a program window for a group.
See Also
Managing Program Groups 



Quick Launch Buttons
You can create a set of Quick Launch buttons for the programs you use most often. Once a 
program has been assigned to a Quick Launch button, just click that button to run the 
program.
To change Quick Launch preferences in the Customize dialog box, double-click the right 
mouse button on any of the Quick Launch buttons.    With the Quick Launch Preferences, you 
can create new Quick Launch buttons, modify or delete existing    buttons, and change the 
position of the buttons on Dashboard.
See Also
Creating Quick Launch Buttons 



Resource Gauge
To help you check your Windows System Resources, Dashboard includes these tools:
The Resource Gauge shows the level of Windows System Resources currently available. As 
your System Resources get low, the needle drops toward Empty, and    you may not be able 
to open new programs.
The Warning Indicator blinks and sounds an alarm as you reach the alarm level for available 
total free memory or Windows System Memory. Double-click to see a list of all programs 
currently running. Try closing programs if you are running out of memory.
The Memory Meter shows the amount of free system memory. The numbers are in kilobytes.
You can see more detailed resource information by double-clicking the Resource Gauge or 
the Memory Meter.
See Also 
Checking Your Resources 



Show Program Menu Button
Click this button to show or hide the Dashboard Program Menu, which lists program groups.



Sizing Bar
With the cursor placed over the Sizing Bar, you can click and drag to change the width of 
Dashboard.
There are Sizing Bars along the left and right edges of Dashboard. When the cursor is placed
over a Sizing Bar, the cursor becomes a double-headed arrow. 
The size of Dashboard is limited by the number of items on Dashboard that can be expanded
or hidden from view.    For example, if the Dashboard window only has one printer icon and 
one Quick Launch button, there's probably no reason to resize.    But if your computer has 
multiple printers, you may have to resize it accordingly. You cannot make Dashboard bigger 
than is necessary to display all items adequately.
Enlarging Dashboard may cause some of its panels (such as the panels for the printers or 
the Quick Launch buttons) to be too big to show all of their items.    When that happens, 
panels on the left will have priority over panels on the right.    For example, if the Quick 
Launch panel is to the left of the printers' panel, more Quick Launch buttons will be visible 
than printers.    Scroll arrows will be next to the printers so you can scroll to see the other 
printers.    To take advantage of this feature, rearrange the panels that you work with most 
often to be on the left side.



System Menu
The System Menu includes standard Windows System menu commands for working with the 
window, plus extra Dashboard commands to switch to other menus and features.
See Also
Launching Programs with the Run Command 



Task Menu
The Task Menu switches among currently open programs.    You can also use the Task menu 
to display an open program on the current full screen view, run new programs, and close all 
programs other than Dashboard, the Program Manager, and DOS applications.
If you make changes to program windows, you can update your extended screens to 
correspond to these program windows by using the Update command on the Task menu.



Title Bar
The Title Bar displays the window caption and can also show date and time, depending on 
the option you choose in the Customize dialog box. Click and drag the title bar to move the 
entire Dashboard.





The Alarm Settings Dialog Box
The Alarm Settings dialog box lets you specify information about an alarm. Specify options for how and 
when the alarm should sound, and then click OK.

Here is a description of the options you can use to define an alarm:
Time:    To set the time for the alarm to sound, select the hour and minutes and enter new 
values. Choose whether time set is AM or PM.
One Time Only:    Choose this option if you want the alarm to sound only once. If you leave 
this box unchecked, the alarm will sound every day at this time.
Alarm Text:    Enter the text here that you want to appear with the alarm message.
Optional Alarm Actions:    To set the alarm to launch a program, enter the program's name
and current working directory. Check the box to have the program opened as minimized.    
Click Browse to see the command lines and working directories for your files. When the 
alarm goes off, Dashboard will automatically open that program in addition to displaying the 
Alarm Text you entered.
Sound:    Choose the alarm's sound from this pull-down menu. To hear a sound, select it in 
the list and click Play Sound.
If you did not install the Sound Driver for PC-Speaker during the Dashboard installation procedure, you 
cannot hear sound with the alarm.    For instructions on installing the driver, see your Dashboard Owner's 
Handbook.



The Clock Alarms Dialog Box
The Clock Alarms dialog box shows all the alarms you've already defined. Double-click any 
alarm to see details. Use buttons to add new alarms or change existing alarms.
Add:    Adds a new alarm.
Edit:    Edits an alarm; click the alarm you want to change and click either the Edit or Delete 
button.
To customize your clock preferences (including the time interval for the Snooze feature), 
click the Configuration button.
See Also
Customizing the Alarm Clock 
Setting an Alarm 



The Customize Dialog Box
Use the Customize dialog box to choose which items to display on Dashboard and the order 
in which they should appear.
The list on the left includes all major items of Dashboard. Click any item, and the right side 
of the dialog box displays the preferences for that item.    Choose the new options you want 
and you'll see the changes on Dashboard.    To keep the changes, click Done and the dialog 
box will close.    Your changes will be put into effect.    If you don't want to keep the changes, 
click Undo, and the Dashboard will appear as before.
Choosing which items to include in your Dashboard
To exclude any item from Dashboard, click the item and click the Hide button. The text "not 
shown" will appear next to the item to indicate that it is not currently included in Dashboard.
To add any item that was previously hidden, click the item and click the Show Item button.
Reordering the items in your Dashboard
The list of Dashboard items includes a line separating the top two items. For items below 
this line, the top-to-bottom sequence corresponds to their left-to-right sequence in 
Dashboard.
To change an item's position, drag it to a new place in the list.
Using custom dashboard configurations
The File Menu in the Customize dialog box lets you configure Dashboard to suit particular 
tasks and save each configuration as a file for future use.    Later on, when you have to get 
that task done, you can load the custom Dashboard configuration for it.
To save a configuration, choose Save or Save As from the File Menu.
Save saves the current configuration into the configuration file currently being used.    The 
caption of the Customize dialog box shows the name of the current file.    Use Save As to 
save to a different file name.
In the Save As dialog box, enter the path and file name for the file in the text box.    A .cfg 
extension is automatically added to the new file name, and the current configuration file 
now changes to the new file name.    Click OK to save the file.
For instructions on working with any of the preferences, click the appropriate topic in the 
following list:
Dashboard Preferences 
Program Menu Preferences 
Quick Launch Preferences 
Clock Preferences 
Extended Screens Preferences 
Resources Preferences 
Printer Manager Preferences 



Dashboard Preferences
To work with Dashboard Preferences, click Dashboard in the list on the left side of the 
Customize dialog box.
Specifying how to display the Dashboard
Choose the Dashboard always in front option if you always want Dashboard in front of all 
other windows. Otherwise, choose the F-Key you want to use to bring Dashboard into view.
Using Dashboard as a shell
Choose Use Dashboard as Windows Shell if you want Dashboard to be the first program to 
run (known as the "shell program") instead of the Program Manager each time you start 
Windows.    
Including program icons in the Dashboard
Choose the Show icons in menus and screens option to see program icons in Dashboard's 
extended screens, Program Menu, and Task Menu.
Choosing a Title Bar display
Under Title Bar Display, use the drop-down list to determine the appearance of the 
Dashboard's title bar. Choose Standard to include only a title. Choose Clock to also include 
the date and time in the title bar.
Choosing an icon for the minimized Dashboard
Under Minimized Display, use the drop-down list to choose the icon to be displayed when the
Dashboard is minimized. You can choose the standard Dashboard icon, the clock icon, or the 
extended screens icon.    If you choose the extended screens icon, you can switch screens by
clicking on the little boxes in the minimized icon.



Program Menu Preferences
To work with Program Menu Preferences, click Program Menu in the list on the left side of the
Customize dialog box.
Choosing whether to include the Program Menu on the Dashboard
To remove the Program Menu from Dashboard, click Program Menu from the list on the left 
and click Hide Item.
If the Program Menu has been removed from Dashboard, the list on the left will indicate that 
the Program Menu is "not shown." To restore the Program Menu on Dashboard, click Program
Menu from the list on the left and click Show Item.

If Dashboard is the shell, you can perform the following functions:
Modifying a program group's color key or description
1. Click a group in the Program Groups list.

2. Click Modify.

3. Enter a new group description or select a new color key setting.

The group description you enter will appear on the Dashboard program menu button.

Creating a new program group
1. Click New.

2. Enter a group description and select a color key setting.

The group description you enter will appear on the Dashboard program menu button.

3. If you want, enter a file name for the group.    The file name setting is optional.

Deleting a program group from the Dashboard
1. Click a group in the Program Groups list.

2. Click Delete.

 
Reordering program groups
Click the program group you want to move in the list and drag it to its new position in the list. The 
Program Menu button for that group will be moved appropriately on the Program Menu.

Regardless of whether Dashboard is the shell or not, you can perform the following functions:

Opening a Group into a Group Window
1. Click a group in the Program Groups list.

2. Click Open.

Specifying a height for the Program Menu
Use the Show 2nd row of text option to display two rows of text on the Program Menu 
buttons..
Choosing whether to display colors in the Program Menu
Each program group can include a color to make it more identifiable. Use the Show Color 
Keys option to turn colors on in the Program Menu.
Updating Dashboard with changes made in the Windows Program Manager



Click the Reread from Program Manager button.

Changes you make to groups with the Program Manager while Dashboard is running will not be reflected 
in the Dashboard groups until you click this button. If you close Dashboard and then run it again, the 
changes will also take effect.

Cancelling changes to Dashboard preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.



Quick Launch Preferences
To work with Quick Launch Preferences, click Quick Launch in the list on the left side of the 
Customize dialog box.
Choosing whether to include Quick Launch buttons on the Dashboard
To remove the Quick Launch buttons from Dashboard, click Quick Launch from the list on the
left and click Hide Item.
If the Quick Launch buttons have been removed from Dashboard, the list on the left will 
indicate that Quick Launch is "not shown." To restore the Quick Launch buttons on 
Dashboard, click Quick Launch from the list on the left and click Show Item.
Adding a new Quick Launch button
1. Click New.

2. Enter a title for the button.

3. Enter the correct command line (path name and filename of the program you want to run) and 
working directory for the program. Click Browse if you don't know the path name for the program.

4. Choose the Run Minimized option if you want the program to be minimized when you open it.

5. If the program includes an icon file, its default icon appears on the Quick Launch button. Click 
Change Icon to change the program icon.

Deleting a Quick Launch button
1. Click the Quick Launch button you want to delete.

2. Click Delete.

Editing a Quick Launch button
1. Click the Quick Launch button you want to change.

2. Make any changes you want, including the title, command line, working directory, icon, and whether 
the program should run minimized.

Moving Quick Launch Buttons
Click the Quick Launch button you want to move in the list and drag it to its new position in the list. 

Choosing a button size for Quick Launch buttons
Choose Mini-Buttons if you want the Quick Launch buttons to be smaller, with only the 
program icon. Choose Labeled Buttons if you want each Quick Launch button to be larger, 
including both the icon and the title.
Canceling changes to Quick Launch preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.



Clock Preferences
To work with Clock Preferences, click Clock in the list on the left side of the Customize dialog 
box.
Choosing whether to include the Clock on Dashboard
To remove the Clock from Dashboard, click Clock from the list on the left and click Hide Item.
If the Clock has been removed from Dashboard, the list on the left will indicate that the 
Clock is "not shown." To restore the Clock on Dashboard, click Clock from the list on the left 
and click Show Item.
Customizing the clock
1. Click a Clock Type option. Analog clocks show time with minute and second hands pointing to 

numbers, and digital clocks represent time as a number.

2. Click to open the Clock Face Menu, and choose an option to specify the appearance of the clock you 
want.

3. Next to Snooze Interval, type the number of minutes in which you want the alarm to reappear after 
you click the Snooze button in an alarm message.

Canceling changes to Clock preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.



Extended Screens Preferences
To work with Extended Screens Preferences, click Extended Screens in the list on the left side
of the Customize dialog box.
Choosing whether to include the extended screens on Dashboard
To remove the extended screens from Dashboard, click Extended Screens from the list on 
the left and click Hide Item.
If the extended screens have been removed from Dashboard, the list on the left will indicate 
that the extended screens are "not shown." To restore the extended screens on Dashboard, 
click Extended Screens from the list on the left and click Show Item.
Specifying the number of extended screens
Click an option to choose the maximum number of extended screens. 

If a number is grayed out, there is not enough room on Dashboard for that many extended screens. To 
make more room on Dashboard, remove items from Dashboard by clicking on one of the Dashboard 
items listed in the Customize dialog box.    You can then select a larger number of extended screens to 
display.

If you decrease the number of extended screens on Dashboard, any applications contained in the 
removed extended screens (the left or right screens) are moved into the closest extended screen 
remaining on Dashboard.

Specifying the background color for the extended screens
Click one of the background options to select a different background for your extended screens.

Canceling changes to Extended Screens preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.



Resources Preferences
To work with Resources Preferences, click Resources in the list on the left side of the 
Customize dialog box.
Dashboard includes an alarm that warns you when the total free memory or your Windows System 
Resources are getting low. You can determine the levels at which you want Dashboard to sound an alarm,
when either total free memory or Windows System Memory reaches the warning level.

Choosing whether to include the Resources on Dashboard
To remove the Resources from Dashboard, click Resources from the list on the left and click 
Hide Item.
If the Resources have been removed from Dashboard, the list on the left will indicate that 
the Resources are "not shown." To restore the Resources on Dashboard, click Resources from
the list on the left and click Show Item.
Choosing when to sound an alarm for low resources
Next to Alarm, enter the number of kilobytes or the percentage of remaining memory at which you want 
Dashboard to sound an alarm.

Selecting a sound for the alarm
Choose the appropriate sound from the drop-down list.    To hear the sound, click the Play 
Sounds button.
If you did not install the Sound Driver for PC-Speaker during the Dashboard installation procedure, you 
cannot hear sound with the alarm.    For instructions on installing the driver, see your Dashboard Owner's 
Handbook.

Canceling changes to Resources preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.



Printer Manager Preferences
To work with Printer Manager Preferences, click Printer Manager in the list on the left side of 
the Customize dialog box.
Choosing whether to include the Printer Manager on Dashboard
To remove the Printer Manager from Dashboard, click Printer Manager from the list on the 
left and click Hide Item.
If the Printer Manager has been removed from Dashboard, the list on the left will indicate 
that Printer Manager is "not shown." To restore the Printer Manager on Dashboard, click 
Printer Manager from the list on the left and click Show Item.
Showing and hiding a printer
To remove a printer from the Printer Manager, click the printer and click Hide Printer.
If a printer has been removed from the Printer Manager, the list will indicate that the printer 
is "not shown." To restore the printer on the Printer Manager, click the printer from the list 
and click Show Printer.
Reordering printers
For the list of printers in the Printer Manager, the top-to-bottom sequence corresponds to 
their left-to-right sequence on Dashboard.
To change a printer's position, drag it to a new place in the list.
Choosing a default printer
1. Click the printer you want as the default printer.

2. Click Set As Default.

Changing a printer's description and icon
1. Click the printer you want to change.

2. Type a description you want to be displayed with the printer icon on Dashboard.

3. Click Change Icon to choose a new printer icon to be displayed for this printer.

Changing the setup of a printer
1. Click the printer you want to change.

2. Click Setup.

3. Use the Windows dialog boxes to change the printer's setup. Refer to the documentation for Windows
and for your printer for more information about setup options.

Canceling changes to Printer Manager preferences
To cancel any changes you have made in the Customize dialog box, click the Undo button.



The Edit Layout Dialog Box
The Edit Layout dialog box lets you change the specifics of a selected program.    The 
information you see in this box was saved automatically by Dashboard when you created the
layout.    After you make your changes, Dashboard will use this information to run programs 
when you use the Load Layout command.
Editing program specifics
1. Enter a name for the program in the Application Name box.

2. Enter the correct command line and working directory.

If you want a particular file instead of just the program to open as part of a layout, enter the command 
line for the file here.

3. Choose a size for the program window from the Window Size drop-down list.

4. To exit the Edit Layout dialog box and save any changes, click OK.

5. To exit the Edit Layout dialog box without saving changes, click Cancel.



The Manage Layouts Dialog Box
The Manage Layouts dialog box lets you edit existing layouts.
Removing a Layout
1. Select the layout in the Layout list.

2.  Click Delete Layout.

Changing the name of a layout
1. Select the layout in the Layout list.

2. Click Rename.

3. Enter the new name in the Rename dialog box and click OK.

Removing a program from a layout
1. Select the program in the Applications for Layout list.

2. Click Delete.

Editing a program's specifics
1. Select the program in the Applications for Layout list.

2. Click Edit.

3. Enter the appropriate information in the Edit Layout dialog box.

Exiting the Manage Layouts dialog box
1. To exit the Manage Layouts dialog box and save any changes made, click Save Changes.

2. To exit the Manage Layouts dialog box without saving changes, click Cancel.



The Resources Dialog Box
The Resources dialog box contains information about your total free memory and Windows 
System Resources.    Use the Resources dialog box to look at resource usage and to set alarm
levels for low resources.    
The list on the left includes all types of resource and system information you can view and 
work with. Click any item; the right side of the dialog box displays information for that item.
To print a selected item from the dialog box, click the Print button.    Dashboard will print a 
copy of the information on your default printer.
For instructions on using any of the specific sections in the dialog box, click one of the 
following topics:
Memory and Resources 
System Environment 
Drive Usage 
Applications Running 
Environment Variables 



Memory and Resources
The Memory and Resources information tells you about your total free memory and Windows
System Resources.    
1. To display Memory and Resources information, click Memory and Resources in the list on the left of 

the Resources dialog box.

2. Type exact kilobytes to set an alarm level for System Memory (the total free memory for your 
computer.)

3. Type a percentage to set an alarm level for System Resources (memory set aside for Windows). 

4. Select a sound for the alarm.

5. To print Memory and Resources information, click the Print button.    Dashboard will print a copy of the
information on your default printer.



System Environment
1. To display System Environment information, click System Environment in the list on the left of the 

Resources dialog box.

System Environment lists information such as CPU type, monitor type, mouse, keyboard, network, 
output port, and output devices installed under Windows.

2. To print System Environment information, click the Print button.    Dashboard will print a copy of the 
information on your default printer.



Drive Usage
1. To display disk space information, click Drive Usage in the list on the left of the Resources dialog box.

Drive Usage shows information about available disk space for each one of the drives on your 
computer.    The information includes floppy drives, hard disk drives, network drives, total disk space, 
used disk space, and available disk space.

2. To print Drive Usage information, click the Print button.    Dashboard will print a copy of the information
on your default printer.



Applications Running
1. To display information about applications that are currently running, click Applications Running in the 

list on the left of the Resources dialog box.

A list of all currently running applications and their memory usage is displayed.    The list is sorted 
according to the amount of memory used by each application.    

2. To update the list of applications, click the Update button.

3. To free memory by closing an application, select it in the list, then click Close Application.

4. To print information about the currently running applications, click the Print button.    Dashboard will 
print a copy of the information on your default printer.



Environment Variables
1. To display Environment Variables information, click Environment Variables in the list on the left of the 

Resources dialog box.

Refer to Windows documentation and to your application's documentation for more information about 
the environment variables you need.

2. To print Environment Variables information, click the Print button.    Dashboard will print a copy of the 
information on your default printer.



The Run Dialog Box
1. Enter the command line for the program to run. Use the Browse button to find the program's location 

and command line. 

2. Choose the Run Minimized option if you want the program to be minimized when you open it.

3. The Command History list shows the last twenty commands that have been entered. If the command 
you want to enter is already listed, you don't have to type it or browse to find it. Simply double-click on
it to enter the information in the command line.

4. Click OK.



The Save Layout Dialog Box
The Save Layout dialog box lets you save all the programs currently running in their current 
positions on the extended screens..
1. Enter a name for the layout in the Layout box.

The Programs box lists all the programs that will be included in the layout.
2. To edit the program's command line and working directory set up by the layout, select a 

program from the list and click Edit.
Make the appropriate changes in the Edit Layout dialog box.

3. To remove a program from a layout, select it from the list and click Delete.
4. To save the current layout, click OK.
5. To exit the Save Layout dialog box without saving changes, click Cancel.



The Printer Manager Change Icon Dialog Box
1. Click the icon you want to use for this printer. Scroll through the box if you want to see more icons.

2. Click OK.



The Quick Launch Change Icon Dialog Box
1. If multiple icons are displayed in the Current Icon box, click the icon you want to use.
2. Change the File Name if the icon you are looking for is associated with a different file. Changing the 

file here will not change the file used to launch this program.

3. Select the icon from the box.    Scroll through the box if you want to see more icons.

4. Click OK.



The Browse Dialog Box
1. Under List Files of Type, use the pull-down menu to choose the types of files you want to 

find.
2. To choose more specific types of files, type their file extensions in the text area under File

Name. For example, to look for files with .CGR and .FRG extensions, type    *.cgr; *.frg.
3. Under Drives, use the pull-down menu to choose the drive where you want to look for 

files.
4. Under Directories, double-click to open directories and browse for files. When a directory 

is opened, files matching the current file names will be displayed in the list on the left.
5. When you find the file you're looking for, double-click it or select it, then click OK.

The selected path and file name are displayed in the Command Line field in the 
Customize dialog box.



The Save Configuration File Dialog Box
You use the Save Configuration File dialog box to save the current Dashboard configuration 
to a new file name.
1. Enter the path and file name for the file in the File Name box.

2. Click OK.

3. Click Done in the Customize dialog box.



The Load Configuration File Dialog Box
You use the Load Configuration File dialog box to load a selected configuration file.    
Dashboard will be displayed according to the settings in the new configuration file.    
1. Enter the path and file name for the file in the Directories and File Name fields.    
2. Click OK.

The file you load becomes the default configuration file.    If you close Dashboard while 
this configuration file is active, Dashboard will save any configuration changes you have 
made to this file.



The Modify Program Group Dialog Box
You use the Modify Program Group dialog box to make changes to an existing Program 
Group.
1. Enter the new name of the group and select a color key setting.    You can also enter the name of the 

group file if you want.

2. Click OK.

3. Click Done.



The New Program Group Dialog Box
You use the New Program Group dialog box to add a Program Group.
1. Enter the name of the new group and select a color key setting.    You can also enter the name of the 

group file if you want.

2. Click OK.

3. Click Done.





Total Free Memory:    The total amount of memory available on your computer, including 
Windows system memory and other memory not allocated to Windows.



Windows System Resources:    Windows reserves a portion of memory for its own use for 
what is known as System Resources.    The two key components of System Resources, called 
USER and GDI (short for Graphics Device Interface), both reserve their own 64K of memory.   
Each running Windows program uses up a portion of System Resources memory, and when 
the available pool of GDI and USER memory runs low, you will not be able to open any new 
Windows programs.



Working Directory:    When you want to work with data files in a different directory than 
the proram you use to create those files, you specify a Working Directory in the Customize 
dialog box.    When you launch the program, the current directory will be the working 
directory.    Here's an example:    Your word processing program, WinWord, is in a directory 
named WORD, but you've specified a working directory named MEMOS.    When you run 
WinWord and use the Open comand, you'll see the working directory displayed in the Open 
File dialog box.




